Introduction to LTspice IV
Workshop

Presented by:

Steve Knudtsen
FAE Linear Technology
sknudtsen@linear.com

Copyright © 2009 Linear Technology. All rights reserved.

LY LNEAR B



Why Use LTspice?

¢ Stable SPICE circuit simulation with
¢ Unlimited number of nodes

¢ Schematic/symbol editor + Over 1100 macromodels of
+ Waveform viewer Linear Technology products
+ 500+ SMPS

¢ Library of passive devices

¢ Fast simulation of switch mode power supplies
+ Steady state detection
o T t ient SPICE = Simulation
urn on transien Program with Integrated
+ Step response Circuit Emphasis
+ Efficiency / power computations

¢ Advanced analysis and simulation options
+ Not covered in this lab class

¢ Outperforms or as powerful as pay-for tools
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Lispice IV

How Do | Get LTspice and Documentation? <=

Go to http://www.linear.com/software

Left click on Download LTspice IV

Follow the instructions to install on your computer
Standalone application that runs on your computer
Users Guide and Demo Circuit collection also available

® 6 6 o o

LTspice IV *Download LTspice IV (Updated May 5, 2009)
LTspice IV is a high performance Spice Il *LTspice Users Guide
simulator, schematic capture and waveform <LTspice Getting Started Guide
viewer with enhancements and models for  <LTspice Demo Circuit Collection
easing the simulation of switching
regulators. Our enhancements to Spice have
made simulating switching regulators extremely
fast compared to normal Spice simulators,
allowing the user to view waveforms for most
switching regulators in just a few minutes.
Included in this download are Spice, Macro
Models for 80% of Linear Technology's
switching regulators, over 200 op amp models,
as well as resistors, transistors and MOSFET
models.
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How Do | Get Started using
LTspice?
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How Do | Get Started using LTspice?

1. Use one of the 100’s of demo circuit available on linear.com
+ Designed and Reviewed by Factory Apps Group
¢ (Go to http://www.linear.com/software

2. Use a pre-drafted test fixture (JIG)
+ Provides a good starting point, but is not production-ready
¢+ Used to prove out part models, and are not complete designs.

+ Components are typically “ideal” components and will need to be
modified based on your operating conditions

3. Use simulation circuits posted on the LTspice Yahoo! User’s
Group. URL = http://tech.groups.yahoo.com/group/LTspice
¢ Also contains many very helpful discussion threads and tutorials

4. Use the schematic editor to create your own design
+ | Tspice contains models for most LTC power devices and many more

You can also check out LTspice capabilities using the education examples
available on C:\Program Files\LTC\SwCADII\examples\Educational
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How Do | Get Started using LTspice?

2. Use a pre-drafted test fixture (JIG)

+ Provides a good starting point, but is not production-ready
¢+ Used to prove out part models, and are not complete designs.

+ Components are typically “ideal” components and will need to be
modified based on your operating conditions

3. Use simulation circuits posted on the LTspice Yahoo! User’s
Group. URL = http://tech.groups.yahoo.com/group/LTspice
¢ Also contains many very helpful discussion threads and tutorials

4. Use the schematic editor to create your own design
+ | Tspice contains models for most LTC power devices and many more
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Demo Circuits on linear.com <

Go to http://lwww.linear.com/software

LTSPICE IV

LTspice IV = Downlead LTepice I (Updated January 23, 2009)
= | Tzpice Uzers Guids

T = e [

LTzpice IV iz a high performance Spice |l =imulator,
zchematic capture and waveform viewer with LTzpice Deme Circuit Collection
enhancementz and modelz for eazing the zimulation of
zwitching regulatorz. Our enhancements to Spice
have made simulating =witching regulators extremehy
fast compared to normal Spice gimulators, allowing the
uzer to view waveforms for most 2witching regulators
in jugt a feww minutes. Included in thiz download are
Spice, Macro Models for 80% of Lingar Technology's
zwitching regulators, over 200 cp amp modelz, az well

as resiztors, tranziztorz and MOSFET models.

Part Number Updated Download

LT1071HVY - 54 and 2. 54 High Efficiency Switching Regulators May 5th, LT1071HV asc
2006

LT1072HY - 1.25A High Efficiency Switching Regulator May 5th, LT1072HY . asc
2006

LT1076HY - Step-Down Switching Regulator May 5th, LT1076HV asc
2008

LT1111 - Micropower DC/DC Converter Adjustable and Fixed 5V, 12V May 28th, LT1111.asc
2006

LT1172HV - 100kHz, 54, 2.5A and 1.25A High Efficiency Switching May 5th, LT1172HV asc

Regulators 2008

LT1173 - Micropower DC/DC Converter Adjustable and Fixed 5V, 12V Jun 12th, LT1173 asc
2006

LT1308B - Single Cell High CurrentMicropower 800kHz Boost DC/DC May 28th, LT13088.a8¢c

Converter 2006

LT1370HVY - 500kHz= High Efficiency 64 Switching Regulator May 26th, LT1370HV asc
2008
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Demo Circults on linear.com

v' Designed and Reviewed by Factory Apps Group

<

in the actual application

affect circuit performance or reliability

+ |t remains the customer's responsibility to verify proper and reliable operation

+ Component substitution and printed circuit board layout may significantly

fiiLinear Technology LTspice/SwitcherCAD Ill - [LTC3412A.asc]
4, File Edit Hierarchy View Simulate Tools Window Help
HeEe 3 7 & | e

HRE s 88 LB 3000

A

Aa op

LTC3412A - 3A, 4MHz, Monolithic Synchronous Step-down Regulator
Input: 3.3V Output: 1.8V @ 3A
IN

c3
22y 100K
3.3 x2 RS
1Meg | Pgood  SVin PVin
L1
Run/ss swiH g - ouTt
c4 1

u1

R4 _@DDDp

cz 75K cs

LTC3412A

R3
Toww Ty, |,

?{1 J )
232K
Ith LY FB i c1

LY LINEAR

309K

SGND

PGND

Note:

~

~

.tran 1.5m startup

If the simulation model is not found please update with the "Sync Release" command from the "Tools" menu.

It remains the customer's responsibility to verify proper and reliable operation in the actual application.

Component substitution and printed circuit board layout may significantly affect circuit performance or reliability

Contact your local sales representative for assistance. This circuit is distributed to customers only for use with LTC parts

Copyright © 2006 Linear Technology Inc. All rights reserved.

Right click to edit "LTC3412A - 34, 4MHz, Monolithic Synchronous Step-down Regulator Input: 3.3V Output: 1.8V @ 3A"
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How Do | Get Started using LTspice?

1. Use one of the 100’s demo circuit available on linear.com
+ Designed and Reviewed by Factory Apps Group
¢ (Go to http://www.linear.com/software

3. Use simulation circuits posted on the LTspice Yahoo! User’s
Group. URL = http://tech.groups.yahoo.com/group/LTspice
¢ Also contains many very helpful discussion threads and tutorials

4. Use the schematic editor to create your own design
+ | Tspice contains models for most LTC power devices and many more
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Start with a New Schematic <

¢ Select File and New Schematic
+ Will open up a blank schematic screen

Féj Linear Technology L... |._||E E|
File View Tools Help ‘l:' Bile Edit Hierarchy Wiew Simulate Tools

X

Féj Linear Technology LTspice... |Z||E

Mew Schematic
T Mew Symbal J@ = '? J{"t@ @\@\e\E\

Ii-q' Open...

@\ﬁ Window Help - O x

Mew Library k

() Print Setup...

1LTC3411.as5c
2 Vawitch2.asc
3 C:\Program Filesh, . \sw.asy —
4 Vswitch.asc

5 1.5V 5V 10mA 1110.asc
& wprobe.asc
FLTC3411.asc

8 LT3014[1].3sc

9L TC3728[1].asc

0 LTC3411[1].asc
1LTC3411[1].asc

2 3V 5V 400mA 1305.asc

Exit
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Add a Component

¢ Use Add a Component or F2

g d L]

- 8 X

Tl AG LL@ s D) © 5 Aa op

'L/‘_ File | Edit Hierarchy View Simulate Tools Window Help - &

ndo Fq x
¥ Unda : Component
| B g e sivre O R |2 10 | |
| Aa Text T
op SPICE Directive 5
SPICE Analysis
? Resistor R
# Capacitor i
3 Inductor N .
| % Diode o |- o Ml Select Component Symbol Ead
EeY component 2 | Tap Directory: | C:APROGRA1\LTCYS wCADIibsym v
. [Em = LA
E3 Mi Cirl+E
LDraw Wire F3
() Label Net F4
<L Place GND el
[=- Place BUS tap
33 Delete F5 Open thiz macromodel's test fisture
B2 Duplicate F&
& Move F7 C:APROGRA™1ALT ChSwCAD ik’
Paste [Comparators] b FermiteBead_Z1) mesfet
T, [Crigital] cap q nif
i Drag F8 o [FilterPraducts] CHSwW g2 nmos
Draw L [Misc] =240 h nmosd
[Opamps] curment ind npn
[DOptosg] diode ind2 npna
Place a new compeonent on the schematic, [PowerProducts] e LED nph3
[References) e load npnd
| |[SpecialFunctions] f lnad2 pif
bi FeriteBead lprp pmos
bi2 FeriteB ead2 Itlirvee pmozd
< I | >
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Selecting a Model & Opening Test Fixture®

1.

Use the “root” part number to search for the model

*

l.e. 3412A

2. Select “Open this macromodel’s test fixture”

1. Enter 3412A

LY LINEAR

m Select Component Symbol

X

Top Directory: | CAPROGRA™ALTCAS wiCADIN b apm w |
P Py 34, 4MHz, Monolithic Synchronous 2 . Se|eCt
Foood Step-down Regulator
R3S v
ith iT FE
fit HMods [ Open this macromodel's test fisture ]
LEND PGN

LTC34124 |

CAPROGRA

“1NLT CASwCADI siEhapm s PoverProductsh

LTC3403 LTC3412 LTC3422
LTC3409 LTC347 24, LTC3423
LTC3410 LTC3413 LTC3d24
LTC3N01.2 LTC3414 LTC3425
LTCI0-1.65 LTC3415 LTC3426
LTC3I0-1.875 LTC34E LTC3427
LTC3I40B LTC3IN 7 LTC3423
LTC3I0B-1.2 LTC341 74 LTC3429
LTC3I0B-1.875 LTC3418 LTC3440
LTC3411 LTC342 LTC3441
L | ¥
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Pre-drafted Test Fixture

¢ Provides a good starting point
+ These simulations / designs are not production-ready
¢ Used to prove out part models, and are not complete designs.

BiLinear Technology LTspice/SwitcherCAD Il - [3412A_asc] E‘@IE|
( File Edit Hierarchy View Simulate Tools Window Help -5 %
e d 9 F | 0 8 B s2o@m 88 /05 + 3 D80

CUNC Ll

Pgood SVin PVin

Runiss sy
Wi LY 4 LT L
LTC3412A
/Rt Mode

SGND PGND

+ It remains the customer’s responsibility to verify proper and reliable

operation in the actual application
+ Printed circuit board layout may significantly affect circuit performance

and reliability
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How Do | Get Started using LTspice?

1. Use one of the 100’s demo circuit available on linear.com
+ Designed and Reviewed by Factory Apps Group
¢ (Go to http://www.linear.com/software

2. Use a pre-drafted test fixture (JIG)

+ Provides a good starting point, but is not production-ready
¢+ Used to prove out part models, and are not complete designs.

+ Components are typically “ideal” components and will need to be
modified based on your operating conditions

4. Use the schematic editor to create your own design
+ | Tspice contains models for most LTC power devices and many more
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LTspice Yahoo! User’'s Group Web Page<#

e : LTspice/SwitcherCAD Il - Windows Internet Explorer

l | R L = T/_”ﬁ http://tech.groups.yahoo.com/group/LTspicef V| +|| X ‘ | £~

File Edit View Favorites Tools Help

Yr - @'Search Web - & B3~ @~ @ 4k Uparade your Toolbar Now! ~ [=J Mail ~ i@ My Yahoo! - »  Links *

e @ l&, LTspice : LTspice/SwitcherCAD I I I -8 i=h - [k Page v i Tools ~

Yahoo! My Yahoo! Mail Search:‘ Web Search |
i Tech - G - Blog - Hel

YAIHOO!®TECH Slg“ I“ ec roups og elp

Groups New User? Sign Up

Find your version of happiness MA seexing A IR YaHoO!
PERSONALS
on Yahoo! Personals.
Search oW «c[ll [l z» I | search |
Search for other groups
Home
fome Join the
Members Only
Messages Activity within 7 days: New Members - £/ New Messages - 14 New Files - New Questions g rO U p
Post
Fles Description here. As of
Photos Dedicated to the exchange of information e =
about LTspice. LTspice/SwitcherCAD IT] | s m 5« & - 5 &1 EBE LBef 06 ¢ S0 b i Sonea - Ma 11
Links (download now) is a complete and fully = [XUEotme e roowsms] | y
Database functional SPICE program that is F - -
available free of charge from Linear 2009 th ere
Polls Technology. !
LETTIER Before using the software, please read the ar e 1 7 630
Calendar License Agreement found in the '
Promote introductory LTspice Help pages. B m e m b e r S I
- @@= Please report bugs directly to LTC. The : -
: program includes the correct address for R 7
Settings that on its Help About dialog box (Menu

eommmand Help=> About

Group Information LTspice/SwitcherCAD III). You will need
to include any relevant files and a note on
how to duplicate the problem.

Members: 11988

Category: Electrical
Founded: Sep 27, 2002 For general questions, please read the =
program Help file, the group FAQ =
and try the group message Search before posting. If you post questions about a specific circuit, it is most
helpful to also upload the schematic file (.asc) and any necessary symbol (.asy) and model files to the Files/Temp

‘ folder. Never upload the big output file (.raw) of a simulation. Yahoo Groups allow you to easily correct or delete

Language: English

‘ Already a member? any upload mistakes.

Sign in to Yahoo

Hyperlinked lists of all uploaded files and links ean be found in Files/ToC.

It is 'members only' to help avoid spammers. Please avoid personal attacks.
Yahoo! Groups Tips The Group Moderators have no affiliation with Linear Technology.
Did you know...

Message search is now
enhanced. find

‘ , |.|F|ff\|2 LTspice Lab Class & Getting Started Guide 15
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How Do | Get Started using LTspice?

Use one of the 100’s demo circuit available on linear.com
+ Designed and Reviewed by Factory Apps Group
¢ (Go to http://www.linear.com/software

Use a pre-drafted test fixture (JIG)

+ Provides a good starting point, but is not production-ready

¢+ Used to prove out part models, and are not complete designs.

+ Components are typically “ideal” components and will need to be
modified based on your operating conditions

Use simulation circuits posted on the LTspice Yahoo! User’s

Group. URL = http://tech.groups.yahoo.com/group/LTspice

¢ Also contains many very helpful discussion threads and tutorials
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Schematic Editing &

Place Circuit Element
Place Diode
Place Inductor
Place Capacitor
Place Resistor

Label Node
Place Ground
Draw Wire
FijLinear Technology SwitcherCAD II1- [5¥ 12v 250mmrrovaasc] S SOONC N\ =10 %]
4, Fle Wiew Window Simulate Edit Help ~ -\ =121 =
Bl B = £ efalal gl Bww %= ea ol LY@+ 320w D] e|in] ] ] )
L~ T D1 _ N
- /, B dy & 4 B S S |
I [ 4.7M ! |
Zoom In g
Move
Pan Dra
Zoom Out g
Autoscale Undo
Redo
Delete Rotate
Duplicate Mirror

Paste b/t Schematics Place Comment

Find Place SPICE directive
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Using Labels to Specify Units for
Component Attributes
(industry standard SPICE unit labels)

¢ K=k=kilo=103 ¢ M=m=milli=10-3
¢ MEG =meg = 10° ¢ U =u=micro=10-6
¢ G=g=giga=10° ¢ N=n=nano=10-9
o T=t=tera=10" ¢ P=p=pico=10-12

¢ F=f=femto=10-15

Hints

+ Use MEG (or meg) to specify 106,
not M

+ Enter 1 for 1 Farad, not 1F
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Wiring up a Simple RC Circuit <&

¢ Using the toolbar, select New Schematic

¢ Using the toolbar, select a Resistor, Capacitor and Ground. Place these
on the schematic as shown below.

¢ Using the toolbar, select Component. From the component window, type
“voltage” in the dialog box, and click “OK” to place a voltage source

K .
File Edit Hierarchy View Simulate Tools Window Help SEIECt Cumponent Symbol E|

A Jd g &£ O QE B (=R S # Tap Directary: |E:\ngram FilesA\LT CSwCADNINib spm v|
Waltage Source, either DC, AL,
FULSE, SINE, 'L, EXP, o
SFFM

voltage
C:A\Program FileshLT CuSwCADINMib zymb,
nphd achottky
pif SLM
Qo Slx
priozd A
php tine
phps waractar
pripd
polcap Zener
res
ez
L4 [ >

LY LINEAR

LTspice IV Lab Class & Getting Started Guide )




Wiring up a Simple RC Circuit &
¢ Using the toolbar, select Wire. Wire up the RC circuit as shown below.

¢ Using the toolbar, select Label Net. Label the input/output nodes as shown
below

¢ Right-click on each component to change its value as shown below

¢ Right-click on the voltage source and enter the parameters shown below
under the “Advanced” tab.

Independent Voltage Source - V1

Furctions DC Value
) [none)

(%) PULSE[1 %2 Tdelay Trise Tiall Ton Period Neyoles]

B

Tools Window Help - 8 x
) SIMNEMoffset Vamp Freq Td Theta Phi Moycles)
@ Eﬂ E [:i:q "%E E'-}\ a\. E\. O EXP W2 Td Taul Td2 Tau2) Small signal AC analysiz AC)
) SFFM[off Wamp Fear MDI Fig) AL Arnplitude:
O PwLIE 1 12 w2 AL Phaze:

) PwL FILE: | | take thiz information vizible on schematic:
Farazitic Properties
VinitiallvE |0 Seres Resistance[02]:
Vor[vE |5 Farallel Capacitance[FL:
Tdelayls] |0 take thiz information vizible on schematic:
Trize[z]: | Tu
Tfallzl [1Tu
Ton[z] |10m
Tperod[z]: | 20m
Meycles: |3
M ake this information visible on schematic: [ Cancel ] [ oK i

LY LINEAR
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Editing Components

¢ Component attributes can be edited by pointing at the component with
the mouse and Right-Clicking

_ Inductor - L1 |X| Capacitor - Cp1

Resistor - R6

e Marufacturer: Coilcraft WManufactursr o

Part Number: DO1E0BP-222 Fart Hurmber: -

Part Mumber;, -
-I:ar'u:el
Select Inductar - I — —

Select Resiztor
[ Show Phase Dot [ ] [ Select Capacitor

Inductor Properties

Fiesiztor Properties : -
Capacitor Properties
5 Inductance[H]: -m :

Peak Current[A]: -2.3
Tolerance[] I:I Yoltage Aatinglv]: I:I
Series Resistance[02]:

Paoweer Batingl: | : !
Parallel Resistance[n]: | 55000 AMS Curent Ratingll | |
Parallel CapacitancelF] Equiv. Series Resistance[0]: -

Farts Per Package: I:I

M Enter new Yalue for Ré M Enter new Value for L1 L M Enter new Value for Cp1
Jugtification 0K Jugtification 0K Jugtification
[Jertical Test [Jertical Test [Jertical Test
I | | = |

21
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Component Database

¢ Components such as
+ Resistors, capacitors, inductors, diodes,
+ Bipolar transistors, MOSFET transistors, JFET transistors
+ Independent voltage and current sources

You can access a database of known devices

Resistor - R&

bl anufacturer;
Part Mumber:

Cancel

[ Select Besistor

Fesiztar Propertiez

M Select Standard Resistor

Inductor - L1

M anufacturer. Coilraft
Part Mumber: DO1608P-222

Select Inductor

Inductor Froperties

IIE

Cancel

Show Phaze Dot []

Capacitor - Cp1

bl anufacturer;
Part Mumber:
Type:

X

[ Select Capacitor ]

[ QutandEdtDatabass | [ ]
[ List All Capacitors in D atabasze ] [ Cancel ]
C[uF] fg. type Part Mo. WVoltage[] Fizer[2] L
0.5 Michicon Al electrolptic UPLTHR47MAH 0.0 3.900 y
0.5 Nichicon Al electrolptic  UPR2&R47MAR 1000 43.000
0.7 Nichicon Al electrolptic UPLTHRESMAH 500 3700
1.0 TDK #5R C1E08<5RIAT0E 100 0.003
1.0 KEMET #5R COB03CI05KER: 100 0.004
1.0 TDK #TR C3216x7RICIOE  1E0 0.007
1.0 & Tantalum Ta)a105kK016 16.0 11.000
1.0 KEMET #iR CO805C105K4R, 160 0031 v

LY LINEAR

[ QutendEditDatabase | [ ok | [ OutandEdtDatabase | [ 0K
[ List &)l Rezistors in Databaze ] [ Cancel ] [ List Al Capacitors in Database ] [ Cancel
Rlo] | Mig | PartMo. Powerlw] Tolerance[%] & LLF] Mfa. type Part Mo Violtage[v]  Rserl]
e Suhh g i Alelectioltic  IPLTHR47MAH 500 3.400
. ' 1.00 05 Nichicon Alelectrolyiic  UPR2aR47Mak 1000 43.000
1 g.?gK D.‘IDD 1'00 0.7 Michicon Alelectrolptic  UPLTHRESMAH 500 3.700
: : : 10 TOK +ER CIE0EERIAINE 100 0003
953K 0100 1.00 1.0 KEMET WER COROZCIOSKER: 100 0.004
1050K 0.100 1.00 10 TOK 7R CIZIEXFRICIE 160 0.007
331K u.1o0 1.00 10 VK Tartaum  TAMATOSKOTE 160 11.000
10.70K 0.100 1.00 — 10 KEMET 7R COS05CI05K4R. 160 0.031
909K 0100 1.00 B il g A bl
11.00K 0100 1.00
887K 0100 1.00
11.30K 0100 1.00
8 RRK n1nn 10N b

Equiv. Parallel Capacitance(F]: | |
Mean Time Between Failurez[hr]: I:I
Farts Per Package: I:I
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How do you run and probe a
circuit in LTspice?
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Running the RC Circuit Simulation &

¢ With the RC circuit in the active window, click on the “Running Person”
button on the tool bar

¢ The Edit Simulation Command window will appear. Set the Stop Time for
60msec, and click “OK”

¢ Using the mouse, click on the “OUT” node to display the output voltage
waveform

Féi Linear Technology LTspice/Switc... Q@@

File Edit Hierarchy View Simulate Tools Window Help

5 Linear Technology L... [= |[O]X] PE E R £ aQaR B BBY &
-l; File Edit Hierarchy View Simulate Tools 1, RC Fitter_Time Domain asc | RC Fiter_Time Domain raw

Window _Help R = RC Filter_Time Domain.asc

BE 3 5 % oS un ——

PULSE[NS 0 16 i 10m 20m 3y ~ ~ ~ ° ~
o Amn0m o

::'Z:::Z:ZZ'Y?::Z:Z:Z:::ZZZ

. PULSE(0501u1lu10m20m3). . . . . .
dran60m -

60ms
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Running the RC Circuit Simulation

¢ Using the mouse, click on the “IN” node to display the input voltage
waveform also

Fii LTspice IV - RC Filter Time Domain.raw

File Wiew Plot Settings Simulation Tools Window Help

HE P A Ao Ed HER sROM O

i: RC Filter Time Domain asc L‘f RC Fitter Time Domain raw
: _[E]x]
s AR e

10K .

Vi L

';Euiiiiiiiiiiiii

" 'PULSE@S504uuwiOm20mz” -~ T

tran 60m

- I
Oms 6ms 12ms 18ms 24ms 30ms 36ms 42ms 48ms 54ms 60ms

‘ , |.|”EN2 LTspice IV Lab Class & Getting Started Guide 25
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Running the RC Circuit Simulation

¢ Split the plot pane by selecting “Add Plot Pane” under the Plot Settings pull

down menu

¢ Drag and drop the V(in) waveform title into the new plot pane

Fij LTspice IV - RC Filter Time Domain.raw

File Wiew Plot Settings Simulation Tools Window Help

ER— = R Rl Ed HeR +Bo M OS

1, RC Fiter Time Domain.asc £ RC Fiter Time Domain raw

G

_tran &0m

Oms 6ms 12ms 18ms 24ms 30ms 3oms 42ms 48ms 5H4ms 60ms

" 'PULSE[@SDMufutOm 20m3)” -~ ° oo

LY LINEAR
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File Edit Hierarchy View Simulate Tools Window Help

B T # faeR B Ha® &

¢ LTspice has an integrated R e o Doror [ B e T oo |
waveform viewer

PULSE[0S 0 14 16 10m 20m3) ~ ~ ~ ° ° T C

1. Plot the voltage on any wire by

[ mnsom

simply point and click /ﬂu

Voltage probe cursor

Oms 12ms 24ms Jbms 48ms b0ms

File Edit Hierarchy View Simulate Tools Window Help

2. Plot the current through any
. . SR~ N ook g HB2Y s 8 L+ G
component with two connections v o [ e

by clicking on the body of the
component (ﬁ

+ R, C,L Current probe cursor

+ Convention of positive current
is from netlist pin #1 to pin #2

LY LINEAR

12ms 24ms Joms 48ms




Running a Demo Circuit <&

¢ Access the LTC3412A demo circuit located in the “LTspice
Training Files” folder on your desktop

¢ Click File ---> Open, and navigate to the LTspice Training Files folder
on your desktop. Look for the file titled “LTC3412A.asc”

‘ , |.|F|ff\|2 LTspice IV Lab Class & Getting Started Guide 28
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Running a Demo Circuit <&
Fij Linear Technology LTspice/SwitcherCAD I... Q@

-L: File Edit Hierarchy View Simulate Tools Window Help

e 3 o £ N Run [+ B & ¢4

:_:.::::::::::”‘T"‘f‘*?f‘“.‘ﬂ'*;’a“:x“’"zm"m@:“f‘“.f“’“.“";‘“::::::::::::::::

f".“fﬁlifﬁl:f 355??&#553555555555555555555555EEEEE Note: A simulation

:.f“:l:l::ﬁﬂ"‘“‘“" S can be paused by

A I ""_’T”_‘ém ﬁllm selecting “pause”
" S Sl = B0 R 0 . under the Simulate

pull-down menu.

. 'ﬂnn‘hn‘lm hulnlﬂ p r dmmes_ This HI -ul‘llhu'h-d‘lnnwhl'rn only Bor pserwih LTC pards- - - - -
-+ Copyright = 2008 Linsar Teshnology Inc. &1l h:lrrl m:.-arw-d- T R R

¢ Select the "Running Man” button on the toolbar
¢ The Simulation will start and waveform window will open up
+ To view waveforms, please continue to the next page....

VA
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Probing a Demo Circuit <&

Click Here i Linear Technology LTspice/SwitcherCAD I... @@
NEIE

forlnpUt File Edit Hierarchy View Simulate Tools Window Help

Waveform |pe @ ¢ £ 1 & o ag S
A O Click Here

..o ATCR4A2A - 3A 4MHZ, Menodible Eynohroneus- Sdepdown Regulador. - . - . . . . . L L L
e e emanman oo for Output

L B |  Waveform

¢ All Demo Circuits have INs and OUTs clearly labeled to help you quickly select
them

¢ Display the waveforms for IN and OUT by clicking on the IN and OUT nodes
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Zooming In and Out on a Waveform

Fii LTspice IV - [LTC3412A DC Load.raw]

h;EiIe View Flot Settings Simulation Tools Window Help

e B 9 F Ak BEd EHRR s+ O3

1, LTC3412A DC Load.asc ¥4 LTC34124 DC Load raw

dx = 202.139ps(4.94709KHz)  dy = 1.254A (slope = 6203.254/s)

¢ Using the mouse, click on inductor L1 to display the inductor current
waveform. When the mouse cursor is on L1, an ammeter symbol appears.

¢ In the waveform window, use the mouse to zoom in and out
+ Click and drag a box about the region you wish to see drawn larger
¢ Using the toolbar, click on “Zoom full extents”, to zoom back out
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Measuring V, | and Time for the Waveform &
(Measurement Using Zoom)

1. Drag a box about the region you wish to measure
+ Left-click, drag, and hold (do not let go of the left mouse key)

2. View the lower left corner of the window for the status bar. The dx
and dy measurement data is displayed here.

3. Use the undo button on the toolbar to return to original waveform

rE Linear Technology ... [_ [O]3X]
i~ File View Plot Settings Simulation ‘
Tools MWindow Help - & =
A= e A O R R H o
1, LTC34128asc | ¥oo LTC3412Amw |
V(out)
dx = 995.984n=(1. 00403 MH) iy = 17my dx = 995.984ns(1.00403MHz) dy = 1.7mV
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Measuring V, | and Time for the Waveform \5
(Measurement Using Cursors)

1. Right click on the waveform name in the waveform window
2. For “Attached Cursor”, select “1st & 2nd’
3. Position cursors to make desired measurements.

¥~ File View Plot Settings Simulation
Tools Window Help -8 x

Be @ T 420 e BEd B

I~ File View Plot Settings Simulation
Tools Window Help e %
Bs H T 0 aqar gig =

1, LTCHM12Amsc| 2 LTCH12Amw |

Delete this Trace ]

Result

LTC3412A.raw X
Vet [1.79361%
Cursar 2
Ylout]
Horz [ 1.41754ms Vet |1.79364%
Dniff [Curzor? - Cursorl ]
Harz: | 292 361ns Vert | 215769y
X = 1416684ms y = 1794050V Right-Click to edit expression. Control-Left Click td Bz |1.DD??MH2 Slope: |21_?43
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Voltage Differences Across Nodes

¢ Click and hold on one node and drag the mouse cursor to another
node

+ Red voltage probe on the first node
+ Black voltage probe on the second node

¢ Will produce a differential voltage measurement

<

%5 Linear Technology LTspice/SwitcherCAD Il - L... = |[B|X]

File Edit Hierarchy View Simulate Tools Window Help

e 3 5 & ROAAR B HE®" +BOM D

1, LTC3412A_DC Loadasc | LTC3412A_DC Load raw |

LTC3412A DC Load asc

I-HDIFI

- /Nl lll
j;’ :;.2»{ ::pi c1 . |cr. |ca
B N l| l Iﬂ-":

>

/S LTC3412A_DC Load.raw - [O][x]

V(OUT,N006)

/
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Example:

Measure across
LTC3412A top
resistor in
feedback divider




Voltage Differences Across Nodes

&

¢ To create a measurement reference node, right-click on the desired
node and select “Mark Reference”

+ A black voltage probe is anchored to the selected node
¢ All measurements in the circuit are now referenced to the node with

the black probe

Pgood in ..
L1 o
unEs E10
1 ) ) .
i R1 o
i —‘;P' . .
h FB — . - - . . . -l-?|.l- - -l-:|"|l
LY id Highlight Net I ' 1
LTCHI2A & Delete Net N
I wode | B Label Net F4
BRW-Al Mark Reference
SGND PGND " tran 1.ﬂTliﬁlrtlli:l . . . . . . . . .

LY LINEAR
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Measuring the Current in a Wire &

¢ To measure the current in a wire, hold down the ALT key and left click
on the wire of interest
+ An ammeter will appear to indicate that the wire current will be displayed

T LTspice IV - LTC3412A.asc =19
i Edit Hierarchy View Simulate Tools Window Help

a0 eR R HBRE Lo AF LMt TDHO o G Ao

Example:

Probe the LTC3412A
circuit in the three
locations shown to
display the different SESSEEEES , ,
Current Waveforms EELTC341ZA.HW I(LD)-I{R1-I(CT)-1(CT) I(LD)-IRD-I{CT)-I{CT)-I(CT)

A

S

LTspice IV Lab Class & Getting Started Guide

36

ALY LNEAR




Average & RMS Calculations <&

Average & RMS Current, Voltage, or Power Dissipation for selected time window
Click on inductor L1 to display the inductor current waveform
Zoom in on the waveform at steady state to display 10-20 cycles

CTRL key + Left Click the I(L1) trace label in the waveform window
+  Waveform summary window will appea.wvhich shows the average and RMS inductor current

L IR R N 2

aar Technology LTspice/SwitcherCA...[= [B][X]

tﬁEiIe Viev.  Plot Settings Simulation Tools Window Help - O ®

FeEe d T * 0 ek Ed HaR B

1, LTC3412A_DC Loadasc | fon '\ TC34128: 03 toad raw |

Example: LD

Measure average and
RMS current for inductor
In LTC3412A circuit.

Zoom in as shown for
this waveform.

Waveform: I(L1) E|

Interval Start: | 1.556ms

Interval End: | 1.571msz
Awerage; | 299894
RMS: | 300724

|x = 1.56462ms y = 3.0726A
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¢ Instantaneous Power Dissipation

¢+ Hold down the Alt key and left click
on the symbol of the LTC3412A

+ Waveform is displayed in units of Watts

¢ Average Power Dissipation

¢ Click, hold, and drag in the waveform
window to display the waveform at
steady state

¢ CTRL+ left click on the Power
Dissipation Trace Label in the waveform
view

+ Waveform summary window will appear
which shows the power dissipation in
the IC and the integral of power (Joules)

Example:

Measure the power dissipation
in the LTC3412A IC

LY LINEAR

File Edit Hierarchy Wiew Simulate Tools Window Help

A d P F RAaaR B HBa® * B

1, LTC3412ADC Load.asc | ¥ LTC3412A DC Load raw

-1 W—}—v|—y—‘

|
_ 1.56ms 1.60ms 1.64ms 1.68ms 1.72ms
Waveform: V(... §|

Interval Start: | 1.4162ms

Interval End:  |[1.4184ms
Average; | 77057 miw
Integral: | 1.6953p]
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Generating a BOM and
Efficiency Report
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BOM -

¢ Under View, select Bill of Material:

+ “Show on Schematic’

View Simulate Tools Window Help

+ “Paste to Clipboard” (can paste into rﬂ@‘m&ma crlez

H&& B0
Excel and columns will be delimited) ] S 200m Back Coi+8
; us Step-Down DC/IDC Convert
_| ¥ show Grid Cirl+G
P& Linear Technology LTspice/SwitcherCAD I1l - [LTC3411.asc] =3 W Mark Unconn, Pins v
‘l:' File Edit Hierarchy View Simulate Tools Window Help = Mark Text Anchors "
d@w T FIRAARED HRE s EMHES L Bill of Materials T
1, LTC3411asc |§2 LTCM11ram Effidency Report N Pacte 1o dgbord F
ar Technology Inc. Al rights reserved. .. - g o — & PICE Netist | it s
Ll Billof Materials — . . - rt & SPICE Error Log o |—
Ref. . Mfg. ... ...l PartMo. . ... Description. | | .. .. - [ S
Visible Ti g
G100 TDK D00 C3225X5R0J226M - capacitor, 22uF, 6.3V “%"5’ |
€2 - TDK - - - -C3226X5R0J226M - -capacitor, 22uF, 6.3V 1 Autorange Y-oie GND
h o efih o oocmaooenaoaooceacooea0ooaa: capacitor, 22pF . . . . . . .. 2 Marching Waves * :
CCthD &l lllllialllllll capdcitor,220pF | 7 Set Probe Reference 47
Cthp - =~ oo capacitor, 10pF
L1 Coileraft- - - - - - - - -DO1608P-222- - inductor, 2.2uH, 2.3A pk - - " W Status Bar ase - : Y
CRA L SRR resistor, 20K . . . | & Toobar Tff{,?.';: ;ﬂ:ﬁ:zﬂzﬁr:gg:t'
B RS R e SRR 7 Window Tabs Ece. This circuit is distributed
b RE T T :::::tz:’ 1UK .......... 20 - . eserved.. . . . . . .
CRth Lt resister, 20K ‘of this ircuit at the bottom of the schematic.
'Ut - Linear Technology "LTC3411: ' - integrated circuit =~~~
..................................................... -
< I >
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Computing Efficiency & Dissipation

¢ To compute efficiency of SMPS circuits:

+ Check the "Stop simulating if steady state is detected" on the Edit
Simulation Command editor

¢ Rerun simulation
+ Use the menu command View=>Efficiency Report

Edit Simulation Command

Féj Linear Technology LTspice/SwitcherCAD I... |:||E||X|

Simulate Tools Window Help - Transient |.-’-\I: Analysiz || DC sweep || Moise || DC Transfer || DCop pnt|

:%f' Run Perform a norvlinear, time-domain simulation.

Pause F | Stop Time:
@ Hailt Ctrl+H i Timne to Start Saving Data:
Clear Waveforms i M asimum Timestep:
Effidency Calculation 4 Start external DC supply voltages at OV

“Shop simulating if steady state is detectedi[v]

Turn off Semicond. cap.

on't reset T=0 when steady state is detected: [
(3
"? Control Panel

Step the lnad current source:

Skip Initial operating point solution: [

Syntax: tran <Tstopr [<option [<optionz]...]

=2
nnnnn mwmwmmmmmmw L
< grifeanly sacr circuit parforreanc o by, o Jtran Tm steady startup
Mmumwwmmmhmmmﬂﬂuwmutm

Copyrighe ® el Unage Tachnopgy e A righpa ragargd. ||

— BT
Enter, Edit, or Select ﬂ'1e Simulaﬁun Cummand
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Viewing Efficiency Report -

mora ¢ Under View, select Efficiency

F&j Linear Technology LTspice/SwitcherCAD IlI - [LTC3411.asc]

View Simulate Tools Window Help - 8 X Report
@ B”' n C? _gz-:uomgrea Ctrl+Z E % %‘ 3:' M a é L
oom Back 1 H
| oo [ g e o + Show on Schematic
o O\Pan ) .
o L + Paste to Clipboard (can
 Efficien ¥ show Grid Crl+G S .
In ¥ Mark Unconn, Pins u L paSte |nt0 EXCGI and
Mark Text Anchors A . . .
. | columns will be delimited)

) 2$f Ef'ﬁcien_cy Report ¥ Shoon Schah'c

‘2 |42 SPICE Netlist Paste to dipboard

“cp1’ SPICE Error Log O

Cih W

* Cthp £2 visible Traces o omWwe - -

L1 £l Autorange y-axis - emW - - - s = 3z = &z & &

- R - r“?aniingﬂaves v SRR .. . . . . . . - [Hfficiency Report -

j E% # Set Probe Reference gﬂg o EmﬂiE"C]’.SBJ%

Rs 3 s Bar . DUW . . . R .

R Coaw L Input: 1.2W @ 3.3V

U B idon Tabs 1azm .~ - Qutput: 997TmW-@999mV -

P;ntthe efficiency report at the bottom of the schematic : : . E'Ef . . . :]rms . . - - -lF;:IE'ak . . Djs;ipatiﬂn .
@ mA 0 OmA 0 0mW
‘2 Y¥mA  1MTImA  0mW
Cp1 OmA ~ OmA OmWw
"Cth - DmA OmA ~ ° ° 0mW-
‘Cthp -~ OmA -~ -~ - - - OmA - - - OmW:
L1 - - 1003mA - - - -1476mA - - - GOmMW -
R . . . Om&A . . . . . 0mA . . . 2uW.
R2 . . mA . . . . O0mA . . . BuW
Ry OmA OmA  2uW
R6 OmA OmA OuW

"Rth =~ O0mA ~ " 0mA = DuW
U1l 103mA 0 0 0 T1TTemA T T M142mW
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Simulating a Transient
Response
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Current Load and Pulse Function &

¢ You can simulate a load with a resistor or current load

¢ In particular, the pulse function for a current load is helpful
for transient response and control loop stability analyses
+ Steps a current load from one value to another value

i Linear Technology LTspice/SwitcherCAD Il - [LTC3411.asc] FEX FiLinear Technology LTspicefSwilcherCAD Il - [3411.raw]
'l; File Edit Herarchy View Smulate Tools Window Help - g x %:;E\Ie Wiew Plok Settings  Simulation  Tools  Window  Help

He B e A O R B HaE 2o d4 88 /-0 F3 % FE  H T A FOAR Ed EHRS tB2Emn A8
1, LTC3411asc ¥ L7ca411 raw £ 3411asc ¥ 3ttam |

1]
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Change the DC Current Load to a Pulse Load o
e
¢ Inthe LTC3412A simulation, RightClick on the current load

¢ Select “Pulse”
¢ Modify the Attributes (see below). Click “OK”.

Independent Current Source - I1

Functions DC Walue .

O frere) BN
(%) PULSE[N 12 Tdelay Trize Tfall Ton Period Moycles)

) SIME[loffset lamp Freq Td Theta Phi Mcycles)

CVEXPI 12 Td1 Taul Td2 Tau2) Small zignal AC analyzis[.AC)

() SFFMilaif lamp Foar MDI Fig) ACAmpliude: ||
O PWLIN 122, ACPhase | |

TABLE[+1 i1 w2i2...
o [ ) kake this information wisible on schematic:

AL 1
EAIE Farazitic Properties
Tdelay[z]: | 1.4m Thig iz an active load:
TTHF:E} ::Z M ake this information wisible on schematic:
Tor[z]: | 100u
Tperiod[z]: | 200u
Meycles:
Make this information visible on schernatic:
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Run the Simulation for Transient Response

G Linear Technology LTspice/SwitcherCAD Iil - LTC3412A...[ |[O|X]
File Edit Hierarchy View Simulate Tools Window Help

: : e E 7 4 Qo Bl HRE 2o a8 -0 F 3 ¥
¢ Run the simulation B e

¢ Click on the OUT LTC3412A.asc .
Vout

¢ Click on the output
current load to
display lout

¢ Notice the
presence of the
pulse load

Viout)

I I [
0.0ms 02ms 04ms 06ms 08ms 1.0ms 1.2ms 1.4ms 1.bms 1.8ms
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AC Analysis
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AC Analysis Overview <&

¢ Performs small signal AC analysis linearized about the DC
operating point

¢ Useful for analysis of filters, networks, stability analysis, and
noise considerations
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Simulating AC Analysis — RC Filter

¢ Single pole filter using RC network
¢ Syntax: .ac <oct, dec, lin> <Nsteps> <StartFreqg>

<EndFreg>

¢ Example: RC network and .ac dec 100 .01 1MEG

V1

R1

10K

AC 1

ouT -3dB point:

.ac dec 100 .01 1MEG
.measure ac 3dB when mag(V(out)=1/sqrt(2)

1/(2*pi*R*C) = 159Hz

Right-click on .tran

command and select
“AC Analysis”

LY LINEAR

LTspice IV Lab Class & Getting Started Guide 49



Simulating AC Analysis — RC Result

Fé Linear Technology LTspice/SwitcherCAD Il ... [2 |[B]X]

File View Flot Settings Simulation Tools Window Help

e d 9 F SO R BEd HB2® ¥BOCHM

1 RC Fiter AC Analysis.asc | ¥ RC Fiter AC Analysis raw

IR |'r|'|r||'|"|'1'IT:I‘|"I —E":I“
1Hz Fi

ac dec 100 .01 1MEG
.measure ac 3dB when mag(Vi{out)=1/sqrt{2}}

Ready
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Importing Third-Party SPICE
Models
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Importing Third-Party Spice Models
To import a third party spice model:
1.) Download the spice model file from the manufacturer’s website

2.) Make sure that the spice model file is located in the same
directory as the LTspice simulation file

3.) Add the following spice directive to the LTspice simulation file
(Edit ---> SPICE Directive):

include spice_model file_name.abc

4.) Modify the component name in the LTspice schematic to
match the component name contained in the spice model file
(RightClick on the device name, and modify accordingly)

Note: The contents of the spice model file can be pasted into the
schematic as a spice directive. When this is done, the .include spice
directive is not needed and the spice model file is no longer needed.

LY LINEAR
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Importing Third-Party Spice Models <

The following items are CRITICAL!

1.) The file name in the .include statement must match the
spice model file name identically! The file name syntax is can
be anything, just make sure that all of the characters match.

2.) The model name in the spice model file must match the
device name in the LTspice schematic identically! The model
name syntax can be anything, just make sure that all of the
characters match.
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Importing Third-Party Spice Models
Spice Model ~ [TEZZEEDTRESE_, | File name = 1N5244B.mod

File “CdtenSommate"view Help

Example #1 [: 1N5244B Eeﬁer Diode
MODEL _1N524481 D Model name = 1N5244B1

+ IS5 = 7.GZE=TU

XTI = 3.0 Summary: The file and model

3_5;-3??2“11 names are irrelevant. Just make

983 sure that the LTspice simulation

R device name and .include file name

1BV = 0.001 match those of the spice model file.

+++++ A+
mZHT==/Mm
o
(=
2
LN

SAUNMAY

Spice Model
Example #2:

T e e —| File name = Joe.txt

File Edit Format View Help
# IN5244B Zener Diode

.M:%ES)EE ?E\.j_Er"ESE & Model name = Everest
Re = 0.3182
N = 1.60
XTI = 2.0
EG = 1.11

C10 = 4.582E-11
M = 0.3377

vl = 2,983

FC = 0.5

ISR = 10E-21

NR = 3.907

Bv = 14.00

IBV = 0.001
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Importing Third-Party Spice Models <

Hands-on Exercise:
1.) Navigate to the LTSpice

Training Files folder

2.) Open up the simulation file B R

titled “Zener Import Example.asc” ke
v out

3.) Open up the SPICE model N T

file titled “1IN5244B.mod” and

note the device model name. PWLO0120) ZX BZX84C12L

4.) Modify the simulation file so
that it uses the 1N5244B third- o
partySPICEmOderasedonthe ... Jgtran1 .
instructions provide on the

previous slides

5.) Run the simulation and probe
the IN and OUT nodes
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Importing Third-Party Spice Models

Fii Linear Technology LTspice/SwitcherCAD Il - Zener... E@@

File Edit Hierarchy View Simulate Tools Window Help

e 3 5 & Qe Bl BEe®m +BOo M S 2

1, Zener Import Example asc ¥~ Zener Import Example raw

Zener Import Example.asc

Solution: W

1.) Zener name changedto W} - - .
1N5244B1 to match model name in L @ ....................
the SPICE model file. RightClick on | T T Wi o420

the diode name text to change.

—
2.) .include SPICE directive added to
link to the SPICE model file. Use
the Edit pulldown menu ---> Spice
Directive to add this SPICE directive
to your simulation.

]
Jinclude 1N5244B.mod

7

~

3.) Result after clicking on the
Running Person symbol on the -
toolbar and probing the IN and OUT

nodes. ~

00s 01s 025 03s 04s 05s 06s 0.4s 08s 09s 1.0s
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Importing Third-Party Spice Models

\5

Types of SPICE Models (open up the SPICE model file to determine)

¢ _MODEL definition (as covered in the previous Zener example)
Change the device name in the simulation schematic to match the device

1.

name in the SPICE model file

2. Add the SPICE directive to the schematic “.include spice_model_file.abc”
¢ _SUBCKT definition

1.
2.

Same as above
Same as above

3. Must CTRL+RightClick on the device and change the Prefix to “X".

LY LINEAR

m Component Attribute Editor X
Open Symbol] C:hprogra™T e evwcadiivibhzymnmos, azy
Thiz determines the twpe of a circuit element, eg.. B, C.oorL
Prefix = | |
Attribute Walue L'
Fefiz /= [
InztMame a1 b
SpiceModel
Walue Si7414DN %
Walued
Spiceling
Spicelines

For additional information,
search LTspice Help using
the key words “third party
model”.
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More Information and Support
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Reminder to Periodically Synch Release

Fé{ Linear Technology LTspice/SwitcherCAD 11l - [LTC3411.asc]

‘l; File Edit Hierarchy View Simulate Tools Window Help

e H T F @, | &l Copy bitmep to Cipboard SBREM O8 LIP3 XZDYDO D O iridaop
Write to a .wmf file -
IIIIIIIIIIIII %P Control Paned LTspice IV Ead _ _ P
,,,,,,,,,,,,, @ Color Preferences R i _
T‘j This utility will check the Linear Technology web site for
""""""" . . new models and a new version of LTspice IV.

....................... You may want to establish your internet connection
in your usual manner before selecting "OK" to continue

| oK H Cancel ]

¢ ltis important to synch your release of LTspice once a month to
get the latest updates:

+ Software updates and bug fixes
+ New models

+ Updated libraries (your library updates will be preserved)
¢+ Sample circuits and examples

Synch Release changes are
captured in the changelog.txt file
located under the following path:

C:\Program Files\LTC\SwCADIII
__or__
C:\Program Files\LTC\LTspicelV
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& scadd

File Edit Bookmark Options

Built-in Help System

¢ Select F1 for help menu

Help

M[=1E3

Help Topics  Back

Print

| < | >» |

0 |a |a

([ Introduction
----- [E] Preface

- Hierarchy
- Wavefarm Viewer

----- [5] Trace Selection

----- B Zooming

----- @ Axis Control
----- @ Flot Panes
----- @ Color Control

[D] LTspice

II--Q Introduction
II--Q Dot Commands

frn B e DO

----- [£] SwitcherCAD Il Overvie
----- [£] Hardware Requirements
----- [£] Software Installation

----- [£] License Agreement/Disc

1

- Schematic Capture
----- @ Basic Schematic Editing
----- @ Label a node name
----- [E] Schematic Colors

----- [£] Placing Components
----- B} Keyboard Shortcuts
----- [£] PCB Metlist Extraction
@ Editing Components

=@ Creating New Symbols

----- [5] Wiewer Overview

----- [£] Wawveform Arithmetic
----- [£] User-Defined Functions

----- @ Attached Cursors
----- @ Sawve Plot Configurations

----- @ LTspice Cverview

=@ Transient Analysis O

-

phic .
_>l_I

Schematic Colors

The menu command Tools=>Color Preferences colors allows you
to set the colors used in displaying the schematics. You
click on an object in the sample schematic and use the red,

green and blue sliders to adjust the colors to your
preferences.

¥~ wWaveForm 4, Schematic |@ Netlistl
1LBO
Ve
1LBI
_____________________ .tran 10m
Click on an item above to change itz colar. k
Selected Item: IWires vI
oK
Selected Item Color Mi T I
Red & |0 |
Green: [——— |0 Apply |
Elte Il |255 Defaults |

Note: Non-electrical graphical anncotations made to
gchematics such as lines and circles will be draw in the

same color Aas a combonent hoc.
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PDF User’'s Guide \@

¢ Download the PDF Users Guide Manual:
+ http://LTspice.linear.com/software/scad3.pdf

+ This is a PDF of the help file database with the addition of a table of
contents and an index.
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Thank you for attending, and happy <%
simulating!

Challenge: Once you return to the office,
go back over the training materials within
one week!
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Appendix A — Summary of Special Mouse and \i—fi
Keyboard Commands

Schematic-Based Special Commands:
1. ALT + LeftClick on a wire
+ This will display the waveform for the current flowing in the wire
2. ALT + LeftClick on a component
+ This will display the instantaneous power dissipation in the component
3. CTRL + RightClick on a component
+ Allows you to edit embedded component attributes

Waveform-Based Special Commands:
1.  CTRL + LeftClick on a waveform title

¢ Displays the average and RMS values for the waveform
2. LeftClick on a waveform title

¢+ Enables a single measurement cursor
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Appendix B — Summary of Additional Features 7

1. To pause a simulation:
+ “Simulate” pull down menu ---> Pause
2. To zoom in/out using the schematic editor:
+ Just use the wheel on your mouse
3. To pan around a schematic
+ Just left-click the mouse and hold, then drag
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